SZECHENYI ISTVAN ALKALMAZOTT MECHANIKA
EGYETEM TANSZEK

Végeselem modszer 2. gyakorlat
térbeli racsos tartd

Adott: '

A szerkezet geometriai méretei:

a=2m

b=4m

c=4m b = _

Anyag: E =2,1-10°MPa=2,1-10"Pa
V= 0,3,

Terhelés:  F, =(—4000k )N

F, =(~2000k |N
Rud keresztmetszet terilete:
T =452,389mm? = 452,389-10°m?
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Racsos szerkezet: | "
a rudak kapcsolédasi pontjaiban (a

csomopontokban) csuklok vannak és ebbél kbvetkezéen: a rudakban csak raderé lép
fel, a ruder6 értéke allando.

Mechanikai allapotok:
Elmozdulasmezé: G (&) =w(&)e.
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Igénybevétel: F =NE.,



e s . . N |
Feszlltségeloszlas a keresztmetszet mentén: o, = e all.

Terhelés: minden erét egy terhelési esetben kell figyelembe venni.
Végeselem modell: huzott-nyomott, linearis rudelem.
Végeselem felosztas: rudanként egy végeselemet kell figyelembe venni.

Meghatarozando:
» A tarto alakvaltozasa, a rudak kozépvonalainak elmozdulasai.
» Tamasztéerok.
» A rudakban ébred6 ruderok.

Szemléltetés:
» A szerkezet deformacié utani alakjanak kirajzoltatasa.
» A csomoponti elmozdulasok értékeinek kiiratasa.
» A legnagyobb elmozdulas helyének megkeresése és elmozdulas értékének
kiiratasa.
Az elmozdulasok szemléltetése a deformalatlan alakon vektorokkal.
Ruderdk nagysaganak meghatarozasa.
Maximalis raderé meghatarozasa.
Az Osszes ruderd kiiratasa.
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Inditsuk el az Abaqus CAE programot. Adjuk meg a munkakonyvtarat a File » Set
Work Directory... paranccsal. A megjelen6 ablakban a New work directory ala
irjuk/masoljuk be a munkakonyvtarunk helyét, vagy valasszuk ki a A select... ikonnal.
Ezutan OK-zuk le az ablakot.

Eile Maodel Viewport View == Set Work Directory L_J&

MNew Model Database | ] Current work directory:
Open... Ctrl+ O Ghgames\SIMULIA\ternp
Metwork QDB Connector e | New work directory:
Close QDB... J\Google Drive\01_education\05_VEM\Abac 5
Set Work Directory... Mote: In file selection dialog boxes, you can

click the work directory icon te jump Pl
Save Ctrl+5 to the current work directory.
Save fs.. Cancel |
Compress MDB...

Il MODULE | PART | geometria megrajzolasa

A program megnyitasa utan alapértelmezésként a Part Modulban vagyunk. Ez a Modul
szolgal a geometria létrehozasara. Ehhez az alabbi Iépéseket kdvessuk:

1. Az eszkoztarbdl kattintsunk a Create Part ikonra. Az ennek hatasara megjelené Create
Part ablakban az alabbi beallitasokat végezzik el:
¢ A Name utan irjuk be az alkatrészlink nevét, legyen terbeli_racsos tarto.
¢ A Modeling Space alatt valasszuk ki, hogy sikbeli, azaz 3D geometriat
szeretnénk rajzolni.
o A Type alatt hagyjuk az alapértelmezett kijelolést a Deformable elétt, mivel
alakvaltozasra képes geometriat szeretnénk.
e A Base Feature alatt valasszuk a Point-ot,.
e Az Approximate size-ot, tehat a modellink méretét itt is bedllithatnank, most
hagyjuk az alapértelmezett 200-on.
A fenti beallitdsok elvégzése utan kattintsunk lent a Continue... gombra.

Ez utan a beviteli mez6ben megjelené Enter the coordinates of the point sorba adjuk
meg 0,0,0 pont koordinatait, majd kattintsunk a kézépsé gombbal.



Module: ) Part S Create Part X
7 Mame: terbeli_racsos
| Creste Maodeling S
A por g Space
ki ® 3D () 2D Planar () Axisymmetric
at Y|
f: [l
et - Type Options
&
i (@ Deformable
e (O Discrete rigid
iscrete rigi
jﬂi %v _ .. Mone available
oo 4. () Analytical rigid
;ﬂ‘ P () Eulerian
.{;B,.‘ E Base Feature
&, % Shape Type
Be O ol
() Shell
Approximate size: | 200
4= | Enterthe coordinates of the point | 0.0,0.0,0.0
Al.l Al.2

2. A Create Datum Point: Enter Coordinates paranccsal adjuk meg a modell fébb pontjait
az xyz koordinataikkal egymas utan. Ezek a kovetkezdk:

° (l,-l,O);
° (1,1,0);
o (-1,1,0);
° (-1,-1,0);
e (0,0,12);
o (4,012);
o (-4,0,12);



&= |X| Coordinates for datum point (X, ¥, Z): [1,-1.0

e ' I
L{@‘ g‘ = X | Coordinates for datum point (X, Y, Z): 'l,'l,li
~
N, 19
- .
=
- 4= X | Coordinates for datum point (X, Y, Z): -4,0,11
L b,
_+_ r
W, Ql__l

Create Datum Point:
Enter Coordinates

A2.1 A2.2

3. A geometria megrajzolasahoz valasszuk az eszkdztarbdl a Create Wire: Point to Point
parancsot. A felugré ablakban a kévetkezd beallitasokat végezziik el:

Az Add method sornal valasszuk a Disjoint wires opciot.

Majd kattintsunk a jobb oldalon Iévé z6ld plusz ikonra, vagyis az Add... ikonra.
Ezutan jobb gombbal jeldljik ki egymas utdn azokat a pontokat, amiket 6ssze
akarunk kétni. (Erdemes az alsé négy pontot a felsével gy 6sszekdtni, hogy
mindig az alsé6 pontot jeldljuk ki el6szér majd uténa a fels6t) Ha létrehoztuk az 5
vonalat, akkor kattintsunk a kézépsé gombbal.

Végul a felugré ablakon kattintsunk az OK-ra.




d'.? Create Wire Feature
Geometry Type
@ Polyline (O Spline
Wire merge scheme
® Imprint wire () Merge wire (O Separate wire

Point Pairs

Add method:

s (O Chained wires () Wires to ground
Point 1 Point 2 +

Set Creation
Create set of wires
[] Create set of vertices

Cancel

A3.1 A3.2 A3.3

4. A kovetkezd Iépésben felvagjuk a 4 db ferde rudat, harom részre. Ehhez valasszuk a
Partition Edge: Enter Parameter parancsot. Ezutan a kdvetkezdket végezziik el:

e Valasszuk ki a felvagando rudakat (4db-ot) majd fogadjuk el a kijelolést k6zépsé
gombbal.

e Alul a beviteli mezében a Normalized edge parameter-nél adjuk meg a 0.3333
értéket, majd kattintsunk a Create Partition gombra. Ezzel Iétrehoztuk aaz also
harmadol6 pontokat.

e Ezutan ne Iépjunk ki a parancsbdl, hanem jeldljik ki a felvagott rudak felsé
részét majd fogadjuk el a kijeldlést a k6zépsé gombbal.

e Alul a beviteli mez8ben a Normalized edge parameter-nél adjuk meg a 0.5
értéket, majd kattintsunk a Create Partition gombra. Ezzel létrehoztuk a felsé
harmadol6 pontokat.

o Végll kdzéps6 gombra kattintva 1épjlnk ki a parancsbél.
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4= X Normalized edge parameter (0 < t < 1): 03333 Create Partition

A4.1 A4.2 A4.3

4= [X| Select the edges to partition | individually M

4= X Normalized edge parameter (0 <t < 1): |0.5

A4.4 A4.5

5. A geometria megrajzolasat a hianyz6 rudak megrajzolasaval fejezzik be. Valasszuk az
eszkoztarbdl a Create Wire: Point to Point parancsot. A felugré ablakban a kdvetkezd
bedllitasokat végezzik el:

e Az Add method sornal valasszuk a Disjoint wires opciét.

¢ Majd kattintsunk a jobb oldalon lévé zéld plusz ikonra, vagyis az Add... ikonra.

o Ezutan jobb gombbal jeldljik ki egymas utan azokat a pontokat, amiket dssze
akarunk kotni. A hibak elkertlése végett érdemes tébb lépésben létrehozni a
vonalakat pl. el6sz6r a 8db vizszintes rudat utana a fels6 harmadolé pontokat a
fels6 két ponttal 6sszekotbket (4db) végul pedig a maradékot (8db). Ha
létrehoztuk a hianyzo vonalat, akkor kattintsunk a kozépsé gombbal.

o Végll a felugré ablakon kattintsunk az OK-ra.



4% Create Wire Feature
Geometry Type
® Polyline () Spline

Wire merge scheme

®) Imprint wire () Merge wire (O Separate wire

Point Pairs

Point 1 Point 2

Set Creation
Create set of wires

[ Create set of vertices

Cancel

A3.1 A3.2

B Y[eln[S/N=RN=IsIel=2 3 tulajdonsagok megadasa

Vélasszuk ki fent a Property modult. Itt tudjuk megadni az anyagjellemzdket, illetve rud
esetén a keresztmetszeti jellemzdket. Ehhez az alabbi 3 1épésen kell végmenni:



1. Anyag definialasa: Els6é lépésként egy anyagot kell definialnunk. Ehhez a Property
modul eszkoztarabdl kattintsunk a Create Material ikonra. A megjelend Edit Material
ablakban végezziik el a kévetkezé beallitasokat:

o Nevezzik el az anyagot: a Name: utan irjuk be, hogy acél
e A linearisan rugalmas anyagjellemz6k megadasahoz a Material Behaviors
mezbben adjuk ki a Mechanical » Elasticity » Elastic parancsot
e Az ekkor megjelené Elastic mezdben az alabbi beallitasokat végezzik el:
oA Type mellett hagyjuk az alapértelmezett Isotropicot (az
anyagtulajdonsagok iranyfliggetlenek)
o A lenti Data tablazatban a Young’s Modulus ala irjuk be a rugalmassagi
tényez6t, azaz 2.1ell (Pa) —t, a Poisson’s Ratio ala pedig a Poisson
tényez6t, azaz 0.3-at.

Y
A & Edit Material -
Maodule: |5 Property
Name: | Material- 1 Name: | Material-1
Description: .
T P Description: P
Material Behaviors Material Behaviors
—
i
o] Create
| Material
E ===l
General | Mechanical | Thermal  Electrical/Magnetic  Other General  Mechanical Thermal Electrical/Magnetic  Other ¥
—
== Plasticity > Hyperelastic S
nZ Damage for Ductile Metals »  Hyperfoam Type: [Isotropic W w Suboptions
nl Damage for Traction Separation Laws > Low Density Feam Ouse temperature-dependent data
&l t Damage for Fiber-Reinforced Composites s Hypoelastic
= Nurmber of field variables: 0
Damage for Elastomers o | EmmEs
m Deformation Plasticity Viscoelastic Moduli time scale (for viscoelasticity): Long-term v
4 ST Datnpasy [ No compression
Ex
Xpansion ] No tension
Brittle Cracking
Sell=
== Eos
y e Young's Poisson's
= Modul Rati
e o
m R 3
i IS
s g e Jum |
e
§ \?I/ oK Cancel oK Cancel

2. Keresztmetszet definialdsa: A Property Modul eszkdztarabdl kattintsunk a Create
Section ikonra. Az ekkor megjelend Create Section ablakban az alabbi beallitasokat
végezzik el:

o Nevezzik el a keresztmetszetet.

e A Category alatt valasszuk ki a Beam —t (rud)

o A Type alatt valasszuk a Truss —t (huzott-nyomott rud)
Ezutan kattintsunk a Continue... gombra. Az ekkor megjelend Edit Section ablakban
a Material mellett megjelent az el6z6 pontban definialt acél (tdbbféle anyag esetén itt
valaszthatnank ki a kivant anyagot) A Cross-section area mellé irjuk be a
keresztmetszet teruletét, azaz 452.389e-6 (m”2) —t. Ezutan kattintsunk az OK
gombra.




Module: | < Property IE S Create Section x %+ Edit Secticn X
O B -
|£ Name: | Seciioal Mame: Section-1
j} Category ~ Type Type: Truss

c O Solid B
i t B . . B
:I‘ Ser:::r] ) Shell i Material: | Material-1 d l@

® Beam Cross-sectional area: | 452.38%e-6

o2 () Other
EI__E" A Temperature variation: Constant through thickness
iﬁ. Continue... Cancel oK Cancel
£ PR

B2.1 B2.2 B2.3

3. Keresztmetszet rudakhoz rendelése: A 2. pontban a kersztmetszethez mar
hozzarendeltik az anyagot, igy most mar csak az el6z6 pontban definialt
keresztmetszetet kell hozzarendelni a rudakhoz. Ehhez kattintsunk a Property modul
eszkoztarabdl az Assign Section ikonra. Ezutan jel6ljik ki az egész racsos tartét, majd
a lenti beviteli mezében kattintsunk a Done gombra. Ekkor megjelenik az Edit Section
Assignement ablak, ahol kivalaszthatjuk a keresztmetszetet. Mivel csak egy
keresztmetszetet definidltunk, hagyjuk a Section melletti kér kersztmetszetet és csk OK-
zuk le az ablakot.

A ) .
Edit Section Assignment X
Module: E w g
_ Region
o, -
lé Region: 5et-3
e
j‘ Section
:'IE} Section: | Section-1 e 35“
% ;Q::tligor; Note: List contains only sections
le‘ <K, applicable to the selected regions.
c Type: Truss
& ¥
Material: Material-1
@
A oK Cancel
B3.1 B3.2

Il MODULE | ASSEMBLY I Zrler

Ennek a lépésnek tobb alkatrészbdl allé szerkezetek esetében van igazan jelentésége, mivel
itt tudjuk létrehozni az 6sszeallitast. Jelenleg csak egy alkatrészink van, ennek ellenére nem
hagyhatd ki a lépés, készitenunk kell egy egy alkatrészbdl allé Osszeallitast. Ehhez
kattintsunk az Assembly modul Create Instance ikonjara, majd a megjelené ablakot OK-zuk
le.

10



= Create Instance *
- Create instances from:
Medule: |5 Assembly : @Fmid O Models
Al mew Parts

Oy
ama

W Create

A Instance

==
I ©
Instance Type

El: -+

;._1.|‘ ﬂ'—l (®) Dependent (mesh on part)

r\'.?/ () Independent (mesh on instance)

— MNote: To change a Dependent instance's
o mesh, you must edit its part's mesh.

i, om ,
[] Aute-effset from other instances
m M.
Apply Cancel
Ci1 Cc2

Bl MODULE | STEP | l6pések megadasa

A Step modulban a végrehajtandé vizsgalat(ok) tipusat (pl. statikus, dinamikus, hétani...),
azok részleteit és sorrendjét tudjuk beallitani. Jelenleg 1 db statikus Iépést kell definialnunk.
Ehhez kattintsunk a Step modul Create Step ikonjara. a megjelend Create Step ablakban
nevezzik el a lépést: a Name: utan irjuk be. A Procedure type-ot hagyjuk az alapértelmezett
General — Static, General — on. Ezutan kattintsunk a Continue... gombra, majd a megjelend
Edit Setup ablakban hagyjunk mindent alapértelmezésen, csak OK-zuk le.

4% Create Step X ¥ Edistep X
Module: |2 st = Name: Step-1
cdule: |5 step Name: Type: Static, General
- Insert new step after Basic Incrementation  Other
.-ﬁ Time period: | 1
"1_? Create Ngzoms & O (This setin ion of nonlinear effect:
(O 0n  of large displacements and affects subsequent steps.)
") Step
" Automatic stabilization: | Nene §
ipep =EE
Procedure type: | General I [ Include adiabatic heating effects
"ﬁE U Dynamic, Temp-disp, Explicit ~
g 4 Geostatic
L Heat transfer
i a Mass diffusion
Soils
oY) r#\ Static, General
4 gl Static, Riks v
'ﬂ..j ¥ < >
—

Bl MODULE | LOAD | peremfeltételek megadasa

A Load modulban tudjuk megadni a kinematikai peremfeltételeket (megfogasokat) és
dinamikai peremfeltételeket (terheléseket). Jelen feladatban 4 megfogast (csuklo) és 2
terhelést (2 koncentralt erd) kell definialni.

1. megfogasok definidlasa: (az alabbi Iépéseket kétszer kell végcsinalni)
e Kattintsunk a Load modul Create Boundary Condition ikonjara.

11




A megjelend Create Boundary Condition ablakban nevezziik el a megfogasokat.
A Category-t hagyjuk az alapértelmezett Mechanical-on, a Types for Selected
Step alatt pedig valasszuk ki a Displacement/Rotation-t. Ezutan kattintsunk a
Continue... gombra.

Jeldljuk ki a rajzon a csuklo helyét (kijeldléskor egy kis piros pont jelenik meg a
kijeldlés helyén).

A lenti beviteli mez6ben kattintsunk a Done-re

Az ekkor megjelend Edit Boundary Condition ablakban akadalyozzuk meg csuklo
esetén az X és Y iranyu, mig gorgd esetén az Y irdnyu elmozdulast. Ehhez csukld
esetén az U1, U2 és U3 elbtti négyzeteket pipaljuk be. Ekkor az elmozdulashoz
automatikusan bekerulnek a 0 értékek. OK-zuk le az ablakot.

Ismételjik meg a fenti Iépéseket még haromszor, hogy mind a négy csuklos
megfogast megadjuk.

csuklé megadasa

Medule: | Load :

1=
LN
Create
Boundary
[ Condition
El.1l
5+ Create Boundary Condition *
MName:
Step: | Step-1 ™

Procedure: Static, General

Category Types for Selected Step
(®) Mechanical Symmetry/Antisymmetry/Encastre
() Electrical/Magnetic Displacement,/Rotation

O Other Velocity/Angular velocity
Connector displacement
Connector velocity

Continue... Cancel

E1.3
Select regions for the boundary condition ( Create set: )

El4

12



2.

% Edit Boundary Condition e

MName: BC-1
Type:  Displacement/Rotation
Step: Step-1 (Static, General)
Region: Set-1

CSYS: (Global) [ L

Distribution: | Uniform | fix)

[ H 0

uz: 0

U3 E

[JuR: radians
[Jur2: radians
] UR3: radians
Amplitude: | (Ramp) ~ ni

Note: The displacement value will be
maintained in subsequent steps.

OK Cancel

E1.5

terhelések definialasa: (az alabbi Iépéseket 2-szer kell végcsinalni F1, és F2 —re)

Kattintsunk a Load modul Create Load ikonjara.

A megjelend Create Load ablakban nevezzik el az erét F1-nek és F2-nek. A
Category-t hagyjuk az alapértelmezett Mechanical-on, a Types for Selected Step
alatt pedig valasszuk ki a Concentrated force-t. Ezutan Kkattintsunk a
Continue... gombra.

Jeldljuk ki a rajzon az F1, F2 helyét. (kijeldléskor egy kis piros pont jelenik meg a
kijelolés helyén).

A lenti beviteli mez6ben kattintsunk a Done-re

Az ekkor megjelené Edit Load ablakban adjuk meg az er6komponensek
nagysagat N-ban: (F1 er6 esetén CF3=-4000, F2 esetén CF3=-2000)

F1 er6 megadasa F2 er6 megadasa
Module: | Load : Module: | Load :
EN= W=

Create | [l Create

Load Load
Ej == rb E
b B2 b @

E2.1 E2.6

13



45 Create Load Iﬁ S+ Create Load Iéj

MName: F1 Name: F2
Step:  terhelés B Step:  terhelés B
Procedure: Static, General Procedure: Static, General
Category Types for Selected Step Category Types for Selected Step
@ Mechanical Concentrated force - © Mechanical Concentrated force -
Moment Moment
Pressure Pressure

mn
m

Shell edge load
Surface traction

Shell edge load

Surface traction

() Electrical/Magnetic Pipe pressure () Electrical/Magnetic | pipe pressure

Body force Body force
) Other Line load (@) Other Line load
) Gravity Gravity
Bolt load i Bolt load i
Conj«'g‘ue... Cancel Conﬁmue... Cancel
L g

E2.2 E2.7

E2.3 E2.8
\ :
Select points for the load ( [7] Create set: | 28 ) Select points for the load ( [7] Cresteset: &1 |)

E2.4 E2.9

% EditLoad p =
Name:  F1 MName: F2
Type:  Concentrated force Type:  Concentrated force
Step: Step-1 (Static, General) Step: Step-1 (Static, General)
Region: Set-3 Region: Set-6
CSYS: (Globaly [p L C5YS: (Global) [ L
Distribution: | Uniform I L Distribution: | Uniform | T
CF1: CF1:
CF2: CF2:
CF3: -400q CF3: -2000
Amplitude: | (Ramp) M R Amplitude: | (Ramp) M P
[ Follow nedal rotation [1 Follow nodal rotation
Note: Force will be applied per node. Note: Force will be applied per node,
QK Cancel OK Cancel

E2.5 E2.10

: 5 MIODULE | MESH halo elkészitése

A végeselem halét a Mesh modulban tudjuk elkésziteni. Legel6szor fent az Object-et allitsuk
at Part-ra, aminek hatasara a Part mellett megjelenik a racsos tarto felirat.

= Mesh E| Model: | Model-1 E| Object: () Assembly {?I\‘Part:f " ricsos tarté :
bg

Module:
fon
Ezutan a haldzast az alabbi lépésekben végezzik el:

1. Elemtipus megadasa:
o Kattintsunk a Mesh modul Assign Element Type ikonjara.
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o Jelbljik ki a teljes racsos tartét, mivel minden radhoz ugyanolyan elemtipust

szeretnénk rendelni.

¢ Alenti beviteli mez6ben kattintsunk a Done gombra

e A megjelendé Element Type ablakban a Family-t allitsuk at alapértelmezésrél
Truss-ra, azaz huzott-nyomott rudelemre (T2D2 tipus), majd OK-zuk le az

ablakot.

S5 Element Type

Element Library Family

@ Standard O Explicit | Piezoslectric
Pipe
Geometric Order Thermal Electric

@ Linear O Quadratic

Truss

Module: |5 Mesh

o
e B
'y F1.2
B s

Assign
| Element Type

Line
[ Hybrid formulation
Element Controls

Scaling factors: Linear bulk viscosity: | 1

T3D2: A2-node linear 3-D truss.

Note: To select an element shape for meshing,
select "Mesh->Controls® frem the main menu

oK

F1.1 F1.3 = Select the regions to be assigned element types m F1.4

2. Elemméret megadasa:
Mivel a racsos tarté huzott-nyomott rudakbdl all, célszerl 1 rudat 1 végeselemnek venni.
Ehhez az alabbi Iépéseket végezziik el:
e Kattitnsunk a Mesh modul Seed Edges ikonjara.
o Jeldljuk ki az egész racsos tartot.
e Alenti beviteli mez&ben kattintsunk a Done gombra.
o A megjelend Local Seeds ablakban a Basic fllén a Method-ot allitsuk By
number-re, a Sizing Controls mezében pedig a Number of elements-et 1-re.

Ezutan OK-zuk le az ablakot.

2 Local Seeds [

Basic | Constraints

Method Bias
) By size @ Mone () Single ) Double

Module: |5 Mesh -

il
e, ag@ F2.2

@ By number

Sizing Controls

MNumber of elements: 175

E;‘: % Set Creation
[T Create set with name: | Edge Seeds-1
9¢ [ Apply | [ Defaults | | Cancel
F2 1 F2 3 ] [X] Select the regions to be assigned local seeds | individually B [E] Use single-bias picking F2 4

3. Végeselem halé elkészitése:
A végeselem halé elkészitéséhez kattintsunk a Mesh modul eszkéztaraban a Mesh Part

ikonra, majd a lenti beviteli mezében az OK to mesh the part? mellett a Yes gombra.

15
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Module: | Mesh : Model:l

HMesh F'arﬂ

N OK to mesh the part? [%]

F3.1

F3.2

Halotulajdonsagok lekérdezése (opcionalis)

A csomodpontok és végeselemek szamanak ellen6rzéséhez a Tools » Query...
Parancsot hasznalhatjuk. A felugré Query ablakban a General Queries mez&ben
kattintsunk a Mesh-re, majd a lenti beviteli mezét a Query entire part-on hagyva a Done
gombra. Ekkor a lenti parbeszédablakban megjelenik a csomdépont szam (Total number
of nodes) és az elemszam (Total number of elements). Jelen feladat 15 csomopontot és
34 végeselemet tartalmaz.

Mesh stack orientation

— — - 5 Query Li_:’- Query entire part E| [7] Display detailed report m
daptivity Feature | Tools Plug-ins Help K7 General Queries
- YooY Point/Nod B
Lt (T 5 | | e F43
z Set ~ Distance .
N ’ Angle
Surface L4 Feature
= v Mesh Partition... Obj shell element normals E 34 elements have been generated on part: Part-1
Datum Beam element tangents

Total number of nodes: 15

- Total numnber of elements: 34
Virtual Topolegy » 34 linear lins clements of typs T3D2
= Display Group  » Element
= Mesh gapsa’mtersectl
Iy} ;

Il MODULE | JOB [ feladat megoldasa

A feladatot a Job modulba atlépve tudjuk lefuttatni. Az ehhez sziikséges Iépések:

1. Feladat definidlasa:

e A Job modul eszkdztarabdl kattintsunk a Create Job ikonra
¢ A megjelené Create Job ablakban kattintsunk a Continue... gombra
o A megjelend Edit Job ablakban hagyjunk mindent alapértelmezésen és OK-zuk le

Module:

== Create Job &J
= Job ]
=9 Mame: | Job-1

Source: | Model EI

[Contiﬂue... [ Cancel
L g

==

2 Edit Job

Name: Job-1
Model: Model-1
Analysis product: Abaqus/Standard

Description:

Submission | General | Memory | Parallelization | Precision

Job Type
@ Full analysis
) Restart
Run Mode
@ Background ©) Queue:

Submit Time

© Immediately

Cancel

Gl.1

G1.2

G1.3
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2.

Feladat lefuttatasa:

o A Job modul eszkdztarabdl kattintsunk a Job Manager ikonra
¢ A megjelend Job manager ablakban alapbdl ki van valasztva az el6bb definialt 1
db feladat (Job-1). Kattintsunk a Submit gombra.

e Ha a Status alatt megjelenik a Completed felirat, akkor a feladat sikeresen
lefutott. Az eredmények megjelenitéséhez kattin

tsunk a Results gombra.

Module: |2 Job H "2 1ob Manager | (2 o0 Manager =)
[

= | Name Model Type Status Name Model Type Status

E! éﬁ Job1 Model-1 Full Analysis None [psta chect] Job-1 Model-1 Full Anslysiz_ Complted [ e

-
@ﬂ i Job

Manager

i ==

iib g e e e e ) o)

:

H YRR RYIEISARVINJ[e]NM credmények megjelenitése

A Results gombra kattintva automatikusan a Visualisation modulba kerulink. Fent
valasszuk ki az U-t vagy az S-t annak megfeleléen, hogy az elmozdulast, vagy a feszliltséget

szeretnénk megjeleniteni. EI8sz6r valasszuk az U-t.
T

A Plot Contours on Deformed Shape ikonra kattintva a deformalt alakot lathatjuk.
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e

Min: +OAC‘ILOe+OOD

4

Bal felll lIathato szinskala alapjan a maximalis elmozdulas 9,901 mm kérdl van.

Az Odb Display Options-ban megjelenithetjik a keresztmetszetet tetszéleges mértékben
felnagyitva. Ezt kiprobalas utan kapcsoljuk ki, mert a tovabbiakban zavaroé lehet.
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[
& 0DB Displa

Curved Lines & Faces

Refinement tlevel:| Coarse ~

it Plot
IR e @
Module: |2 Visualization  [»] """,

g |
(Used when Visible Edges = Feature edges)

Animate  Report

Elements with No Results

Color:

123]
Lz1a Idealizations

Render beam profiles

Scale factor: |10

" [ Render shell thickness.
Odb Display
<a'

-

or: [

WModel Change

Account for deactivated elements

A Common Plot Options-ban a Basic flilon beallithatjuk a deformacio felnagyitasanak
csomopontok és elemek sorszamanak

mértékét, a Labels flloén bekapcsolhatjuk a
megjelenitését.

—e

ult  Plot Animate R
CERJEE 1) i e
Medule: |= Visualizatic

General Entity Display Constraints  Sweep/Extrude

Defaults

Mirror/Pattern

2 Common Plot Options B =)
Basic | Color & Style | Labels | Normals | Other
Render Style Visible Edges
*) Wireframe () Hidden © All edges
©Filled @ Shaded @ Bderior edges

Deformation Scale Factor © Feature edges

(©) Auto-compute (160.603) (© Free edges
® Uniform © Nonuniform () No edges
po

Value: 200 T

I 12l 15
L 3|

Commeaon Options

[

A

d; Commeon Plot Options

Basic Color 8 Style Labels Normals  Other
Labels and Symbuols

Set Font for All Model Labels...

Show element labels  Color:
[ Show face labels
Show node labels

[J Show node symbols
o] Size

|
Color

Color Code

Allow color code selections to override
options in this dialog

Probe Annotations

Set Font|  Color |HE

oK Defaults Cancel

A Contour Options-ban a Limits fllén bekapcsolhatjuk a max/min helyek megjelenitését.
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4 Contour Plot Options X
VIOOUIE: || Visuanization
Basic Color&Style Limits  Other

;)'. ARE Note: User-defined interval values override
—_— 12j2) the settings below.

I, Mar  MinMax
=§ Max @ Auto-compute (0.00890062) ] Show location
B B,

O Specify: |0.00990062
N
El%J Contour Options

Min: @ Auto-compute (0) Show location
O Specify: g

Auto-Computed Limits

When auto-computing animation limits:

T

A+

7 H,—,__ Use limits from all frames. vl
He
A
O s
oK Apply Defaults Cancel
wsdt at?

Fent a fesziltséget valasztva a Contour Plot Options Basic fulén a Contour Type-ot
allitsuk Quilt-re

; .
2= Contour Plot Options . ==
Basic | Color & Style | Limits | Other

Contour Type
) Line ©) Banded @ Quilt () Isosurface
[7] Show tick marks for line elements
ContourIntervals
12
@ Discrete =]
Interval type: Uniform [+]
3—}"-‘ Primary B u H Magnitude B

CF ") Contour Method

E @ Texdure-mapped () Tessellated

RF g

S

oK [C4pply ] [ Defauits ] [ Cancel |

b
-
+
+
+
R
+
45
+
i
+
+
+1.
+
+1.

Az adatok tablazatszeri lekéréséhez hasznaljuk a Report »Field Output... parancsot.

e A Position-t Unique Nodal-ra allitva jel6ljik ki az RF (reakciderd) és az U
(elmozdulas) alatti négyzeteket. Ezzel a reakciderdk, illetve az elmozdulasok
nagysagat, illetve x és y 6sszetevdit tudjuk lekérni csomdpontonként.

o Kattintsunk az Apply gombra

e Szedjuk ki az 6sszes pipat

e A Position mellett valasszuk a Centroid-ot

o Az S (feszlltség) alatt valasszuk a Mises-t. Ezzel a HMH szerinti redukalt
feszliltséget tudjuk lekérni elemenként.

o Kattintsunk ismét az Apply gombra.
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Animate | Report Options

1L w2
= Visualizi

Free Body Cut...

Tools

:/Google Driv

Plug-i
A

1
I |
2 Report Field Output 5 & Report Field Output S 2 report Field Output ==
Step/Frame Step/Frame Step/Frame

Step: L, terhelés

Frame: 1 [Step/Frame..
Varizble | Setup

Step: 1, terhelés

Frame: 1 [Step/Frame.
Variable | Setup

Output Variables

P[] CF: Point lozds
» [ E: Strain components
¥ [¥] RF: Reaction force

- Spatial displacement

Position: | Unique Nodal [

Click checkboxes or edit the identifiers shown next to Edit below.

Step: 1, terhelés

Frame: 1 [Step/Framen.
Variable | Setup

Output Varisbles

Position: | Unique Nodal [

P[] CF: Point loads
P[] E: Strain components
¥ [[] RF: Reaction force
[7] Magnitude
[CIRFL
CIRR2

P [7]s: Stress components.

Click checkboxes or edit the identifiers shown next to Edit below.

Output Variables

Pasition: | Centroid

P[] E: Strain components
v

Stress components

[

[] Max. Principal

Click checkboxes or edit the identifiers shown next to Edit below.

[7] Max. In-Plane Principal
[] Max. In-Plane Principal (Abs)
[Z] Min. In-Plane Principal

[] Mas. Principal (Abs)

i

W [[] U: Spatial displacement [7] Min. Principal
Magnitude [ Magnitude [ Tresca
u
u2 gu [C] Pressure
Cuz [y [] Third Invariant
[su
Edit: | URF Edit Edit: S Mises
Section point: Section point Section point:
omy

A munkakonyvtarban a fentiek hatasara egy abaqus.prt nevii fajl keletkezett, mely a lekért
adatokat tartalmazza. Ezt a fijlt jegyzettdbmb vagy mas notepad alkalmazassal tudjuk

megnyitni és az adatokat kiolvasni.
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